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Enabling HackerTracker Audible
Alarms

HackerTracker now has the option of an audible alarm.  If you wish
to hear a “beep” when an alarm is issued, follow the steps below:

1. Access CAS for Windows and select HackerTracker Criteria
from the Administration menu.

2. Complete the dialog box to setup a site’s criteria and click
Apply.

3. Click Edit and check [X] Beep on Alarm.

The Beep on Alarm feature is either enabled or disabled globally
for HackerTracker. This includes all criteria sets and, in a multi-
site system, all sites.

4. When complete, click Apply then Close.

This change affects Pages 8-4 and 8-5 (new feature "Beep on Alarm")
in the CAS for Windows Installation and User's Guide.

CAS for Windows
Version 2.2 Addendum

CAS for Windows™ Version 2.2 upgrades your CAS software for
use with Windows 95®.  Use this addendum as a supplement to the
CAS for Windows Installation and User's Guide (555-006-517, issue
1, August 1995). The specific page numbers affected by the new
software version are indicated by a  .  The changes include:

New PC hardware requirements

Windows 95 Startup utilities to install CAS software

New, Windows 95-compatible version of the Remote Access
software (Carbon Copy 3.0)

New FAX driver for the HackerTracker pager/FAX options

Windows 95 Backup and Restore utilities to support tape
and floppy disk backups

Windows 95 network sharing utilities for the G3-MA Data
Transfer Option

Creating CAS for Windows icons in color and viewing them
on the Windows 95 Task Bar

Setting up an audible HackerTracker alarm

Please review the following pages and make the necessary notations
in your CAS for Windows Installation and User's Guide.

The CAS dialog boxes and icons now have a Windows 95 "look."
These elements, however, retain their original functions.

Familiar icons appear as buttons at the bottom of your screen and
dialog boxes — except for the title bar — appear exactly as their
Windows 3.1 counterparts shown in the CAS for Windows Installation
and User's Guide.
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Hardware Requirements

The recommended minimum PC configurations are shown below.

Class/ RAM Monthly Call Available Hard Disk (Mb)
Processor Speed (Mb) Record Volume 1 month min 2 mths

486 / 33 8 250,000 60 200

486 / 100 12 500,000 80 250

Pentium / 90 16 750,000 100 300

Pentium / 133 16 1,000,000 140 500

Pentium / 166 16 over 1,000,000 280 1200

Software Windows 95 default settings + Backup Disk Tools,  NO disk
compression tools

Devices Windows 95-compatible bus or PS/2-type  mouse, VGA color
monitor, parallel printer

Windows 95-compatible multi-port boards such as the Comtrol
Rocket Port Board (if more than 2 serial ports are needed)

Windows 95-compatible tape drive — 120, 525, or 1,000 Mb

Serial
Ports

Single site: COM1 = Remote Access; COM2 = SMDR input.
Systems using the Call Sender and/or HackerTracker
FAX/pager modems require a compatible multi-port board
(options, Remote Access may share either modem).

Multi-site systems require multi-port boards:

COM1 = Remote Access; COM3 - COM10 (or higher, if using
more than one 8-port board):

— 1 port per direct SMDR input

— 1 port per modem polling 10 sites

— 1 port for Callback Receiver modem (optional)

— 1 port for HackerTracker FAX/pager modem (optional,
Remote Access may share this modem)

These changes affect Pages 2-2,  C-2 in the CAS for Windows Installation
and User's Guide.

Creating Colored Icons

If CAS for Windows icons appear in black and white, use the steps
below to change them to colors.

1. Shut down CAS for Windows and return to your desktop.

2. Click the right mouse button and select Properties from the
resulting menu.

3. Select the Settings tab and set the Desktop area for at least
800x600 pixels.

4. Change Font Size to Large Fonts and click Apply.

5. Click Yes to Restore PC.  This causes CAS and Windows 95 to
automatically restart.

Monitor resolution and card styles can vary.  If this procedure does
not produce color icons, repeat the procedure except for Step 4.
Instead of changing to large fonts, click Custom and enter a font
scale of 150% or greater.

Viewing CAS Icons on the Task Bar

Recommendations for viewing CAS icons on the Windows 95 task
bar are listed below:

If your have multiple CAS sites, your task bar may have too
many icons to view clearly.  Increase the size of your task
bar to fully view all icons.

If you set the task bar’s properties to “auto hide” you may
not see CAS alarms when they occur.
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2. Click the Restore tab. Then in the Restore From field, choose
the media type that contains the data you are restoring.

3. Select the Backup Set you wish to restore, then click Next
Step.  You may experience a delay while Backup searches for it.

4. Check the box next to casw and click Start Restore.

5. When complete, close Microsoft Backup. If a CAS for Windows
shutdown was necessary, select Run from the Start menu,
enter emlog, and click OK.

G3-MA Data Transfer Option

If you are using CAS for Windows with a DEFINITY® Enterprise
switch, you may use Windows 95 network sharing tools to set up the
G3-MA Data Transfer Option.

For example, at the G3-MA PC, after you set up the G3-MA data
transfer directory ("AUTODIR" under C:\G3-MA), proceed as
follows:

1. Use the Explorer to
find and select
AUTODIR.

2. Open its Properties
under the Explorer's
File menu.

3. Click on the Sharing
tab and select Share
As, Full access type,
and no passwords.

(see sample)

This change affects Pages E-3 and E-4 in the CAS for Windows
Installation and User's Guide.

Software Installation

To install the CAS for Windows software, insert its Setup diskette in
any disk drive, select Run from the Start menu, and enter the drive
letter followed by ":setup" (for example, a:setup for the A drive).

This change affects Page 2-4 (Step 2) in the CAS for Windows
Installation and User's Guide.

Remote Access

You will be shipped the new version of the Remote Access software
(Carbon Copy 3.0), compatible with Windows 95. This includes
updated documentation to install and configure the "Host" package.
If you are using the "Guest" package, you will receive its
documentation, Microcom Carbon Copy Version 3.0 for Windows
(Microcom 24-0000839-001).

This change affects Page viii (Related Resources) and Appendix F in
the CAS for Windows Installation and User's Guide (use information
from the new documentation).

HackerTracker FAX Setup

The system now uses Microsoft Exchange to fax HackerTracker
alarms. This requires installing Windows 95 Microsoft Exchange and
Microsoft Fax and performing a preliminary setup.

Installing Microsoft Exchange

If the Inbox icon appears on your desktop, Microsoft Exchange is
already installed and you may proceed to Installing Microsoft Fax.

1. From the Start menu on your desktop, select Settings and then
Control Panel.

2. Double-click on the Add/Remove Programs icon, select the
Windows Setup tab, and check the Microsoft Exchange box.

3. Follow the on-screen instructions to complete the installation.
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Installing Microsoft Fax

First, check if Microsoft Fax is installed: double-click on the Inbox
icon on your desktop (if the Choose Profiles dialog box appears,
simply click OK) and select Services from the Tools menu. If
Microsoft Fax appears as one of the services, it is already installed
and you may proceed to Setting Up Microsoft Exchange.

1. From the desktop, select Settings from the Start menu, and
then Control Panel. Double-click on the Add/Remove
Programs icon and select the Windows Setup tab.

2. Scroll down to Microsoft Fax and check its box, then click
Details to verify that Microsoft Fax Services and Microsoft
Fax View are both checked.

3. Follow the on-screen instructions to complete the installation.

Setting Up Microsoft Exchange

1. If this is a “first-time” configuration, double-click on the Inbox
icon on your desktop. When the Choose Profile dialog box
appears, click on the New button and proceed to Step 3.

2. If a configuration already exists, double-click on Start, select
Settings and then Control Panel. Open the Mail and Fax icon,
click Show Profiles on the resulting dialog box, and then Add.

3. When the Inbox Setup Wizard dialog box appears, select
Manually configure information service, click Next>, enter a
Profile Name (CASW22 is recommended), and click Next>.

4. When the CASW22 Properties dialog box appears:

a. Click Add and select Microsoft Fax. Under the User tab,
enter Your full name (the sender of HackerTracker faxes)
and his/her Fax Number.  All other information is optional.

Click OK, then Yes. When the Modem dialog box appears,
select the appropriate modem and click OK.

It is advisable to use a dedicated modem (i.e., other than the
HackerTracker pager modem) to avoid port contention when an
alarm occurs and CAS tries dialing out to both devices.

b. Type the file name for the type of backup and media that
you want to define (use the table below) and then click
Save.

Backup Media Set File Name

Full CAS system floppy diskette caswdsys.set

tape caswtsys.set

Current CAS data floppy diskette caswdcur.set

tape caswtcur.set

Archive CAS data floppy diskette caswdarc.set

tape caswtarc.set

8. Repeat Steps 5 to 7 until you have completed the definition of all
backup sets (full, current, and archive) for the type of media you
will be using.  When complete, exit the Backup function.

Backing Up Data

1. Have your supply of formatted backup media ready, then load it
into the appropriate drive.

2. Access CAS for Windows and select Backup from the Utility
menu.

3. When the dialog box appears:

a. Select the media and the accounting period to backup and
click OK. Follow the prompts to continue.

b. When complete, label the tape or diskettes with the backup
dates and sequence (if necessary).

Restoring Data

CAUTION

Restore overwrites data.  Do not restore to your current directory.
Also, do not proceed unless you have a recent backup of your full
system, current, and archive databases.  Finally, before performing
a full or current restore of data, shut down CAS for Windows.

1. From your desktop, select Run from the Start menu, enter
backup, and click OK.
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b. If defining a full backup, you may proceed to Step 6. Other-
wise, double-click on Casw to display CAS subdirectories.
Check the box by Cur (for a current backup) or by
Archive.acv (for an archive backup, if it exists).

6. Click on the Next Step> button.  When a dialog box similar to
the one below appears, select where to back up: for tapes, click
on your tape drive; for floppy disks, click on your floppy drive.

7. Select Save As... from the File menu.

a. When a dialog box similar to the one below appears, select
to save in the Bin directory under the Casw directory.

b. Back at the CASW22 Properties dialog box, click Add and
select Personal Folders. Enter the file name (casw22.pst)
under your CAS for Windows directory — for example,
c:\casw\casw22.pst — and click Open.

 When the Create Microsoft Personal Folders dialog box
appears, click OK.  DO NOT ENTER A PASSWORD.

c. Back at the CASW22 Properties dialog box, click Add and
select Personal Address Book.  Under the Personal
Address Book tab, enter the file name (casw22.pab) under
your CAS for Windows directory — for example,
c:\casw\casw22.pab — and click OK.

5. Back at the CASW22 Properties dialog box, click OK to keep
these settings and exit.

6. If this is a “first-time” configuration or your Inbox is not in your
Start-up group, the Inbox Setup Wizard includes the option
Add Inbox to the StartUp Group.  Check this option to have
Microsoft Exchange running at the same time CAS for Windows
is operating.  Click in succession Next>, Finish, and Close.

A "first-time" configuration starts Microsoft Exchange automati-
cally after completing the above — so if this is the case, you may
proceed directly to Step 8.

7. Back at the desktop, start Microsoft Exchange by clicking on the
Inbox icon. Then complete the following steps:

a. Select Options from the Tools menu. Then select Always
use this profile and verify that CASW22 is displayed.  Click
OK to save settings.

b. Select Address from the Tools menu. Then select New
Entry from the File menu.

c. Select Fax and click OK. Enter the Name to show on
cover page (the recipient of HackerTracker fax alarms) and
his/her Fax Number.  Click Apply, then OK. Close the
dialog box and leave Microsoft Exchange running.

8. Access CAS for Windows and select HackerTracker Criteria
from the Administration menu, then FAX Setup.
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Enter the name the recipient of HackerTracker faxes (the name
entered in Step 7c) and click OK to complete this procedure.

These changes affect Pages 8-2, 8-3 (Steps 1b - 1l are not needed),
and 8-7 in the CAS for Windows Installation and User's Guide.

Backup and Restore

The Backup and Restore functions have been enhanced to support
tape as well as floppy diskette backups. CAS backups copy the full
system or the current or archived period’s data onto removable
media. You now use the Windows 95 Restore function to restore
prior CAS backups to the original locations — typically, to run reports
on archived data or to rebuild CAS files after a system failure.

Tape backups are recommended for installations with a large call
record database. Other recommendations:

Backup When Comments

Full* Upon initial installation
and any time you install
an upgrade or update

Keep two backup sets, rotating
them as needed: one with the latest
data and the other, with the prior
backup

Archive After a period closes Keep each backup set, do not reuse

Current Weekly or daily, depen-
ding on the volume and
importance of your data

Keep two backup sets, rotating
them as needed: one with the latest
data and the other, with the prior
backup

* Remember that a full backup is current up to when it was made and that "current"
backups contain only partial data. Used together, they minimize the need for full
backups, which might interfere with call collection and polling schedules. Thus, for a
full restore you need the latest "full" plus the "current" backup.

These changes affect Pages 7-2 and 7-3 in the CAS for Windows
Installation and User's Guide.

Backup / Restore Initialization

The CAS Backup function requires you to pre-define file sets
containing specific instructions.  To do so, proceed as follows:

1. If the Windows Backup tool is already installed, proceed directly
to Step 2. Otherwise, complete these steps:

a. From the Start menu on your desktop, select Settings, then
Control Panel. Double-click on Add/Remove Programs.

b. Select the Windows Setup tab, check the Disk Tools box,
then click Details. Check the Backup box and click OK.

c. Follow the on-screen instructions to complete the
installation.

2. Back at your desktop, open the Start menu, select Run, enter
backup, and click OK.

3. Click OK if the Welcome to Microsoft Backup notice(s) appears
(you may elect not to show these again by checking the
appropriate box on the notice window).

4. Select Options... from the Settings menu.

a. Click on the Backup tab and select these items:

Quit Backup after operation is finished
Type of backup  Full:  backup of all selected files
Advanced options  Use data compression

b. Click on the Restore tab and select these items:

Quit Backup after operation is finished
Restore backed up files to:  Original locations
Advanced Options  Overwrite files

c. Click OK and proceed to the next step.

The next three steps define (respectively) the source, destination,
and file name for a specific type of backup. Start with a "full" backup;
repeat for a "current" backup, then for an "archive" if it exists (new
installations do not have an archive. You must define its backup set
after the file is created at the closing of the first accounting period).

5. Back at the main dialog's Backup tab, select what to back up:

a. Double-click on the drive where you installed CAS, then
check the box by Casw in the right side of the window. (See
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Enter the name the recipient of HackerTracker faxes (the name
entered in Step 7c) and click OK to complete this procedure.

These changes affect Pages 8-2, 8-3 (Steps 1b - 1l are not needed),
and 8-7 in the CAS for Windows Installation and User's Guide.

Backup and Restore

The Backup and Restore functions have been enhanced to support
tape as well as floppy diskette backups. CAS backups copy the full
system or the current or archived period’s data onto removable
media. You now use the Windows 95 Restore function to restore
prior CAS backups to the original locations — typically, to run reports
on archived data or to rebuild CAS files after a system failure.

Tape backups are recommended for installations with a large call
record database. Other recommendations:

Backup When Comments

Full* Upon initial installation
and any time you install
an upgrade or update

Keep two backup sets, rotating
them as needed: one with the latest
data and the other, with the prior
backup

Archive After a period closes Keep each backup set, do not reuse

Current Weekly or daily, depen-
ding on the volume and
importance of your data

Keep two backup sets, rotating
them as needed: one with the latest
data and the other, with the prior
backup

* Remember that a full backup is current up to when it was made and that "current"
backups contain only partial data. Used together, they minimize the need for full
backups, which might interfere with call collection and polling schedules. Thus, for a
full restore you need the latest "full" plus the "current" backup.

These changes affect Pages 7-2 and 7-3 in the CAS for Windows
Installation and User's Guide.

Backup / Restore Initialization

The CAS Backup function requires you to pre-define file sets
containing specific instructions.  To do so, proceed as follows:

1. If the Windows Backup tool is already installed, proceed directly
to Step 2. Otherwise, complete these steps:

a. From the Start menu on your desktop, select Settings, then
Control Panel. Double-click on Add/Remove Programs.

b. Select the Windows Setup tab, check the Disk Tools box,
then click Details. Check the Backup box and click OK.

c. Follow the on-screen instructions to complete the
installation.

2. Back at your desktop, open the Start menu, select Run, enter
backup, and click OK.

3. Click OK if the Welcome to Microsoft Backup notice(s) appears
(you may elect not to show these again by checking the
appropriate box on the notice window).

4. Select Options... from the Settings menu.

a. Click on the Backup tab and select these items:

Quit Backup after operation is finished
Type of backup  Full:  backup of all selected files
Advanced options  Use data compression

b. Click on the Restore tab and select these items:

Quit Backup after operation is finished
Restore backed up files to:  Original locations
Advanced Options  Overwrite files

c. Click OK and proceed to the next step.

The next three steps define (respectively) the source, destination,
and file name for a specific type of backup. Start with a "full" backup;
repeat for a "current" backup, then for an "archive" if it exists (new
installations do not have an archive. You must define its backup set
after the file is created at the closing of the first accounting period).

5. Back at the main dialog's Backup tab, select what to back up:

a. Double-click on the drive where you installed CAS, then
check the box by Casw in the right side of the window. (See
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sample on the next page.)
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b. If defining a full backup, you may proceed to Step 6. Other-
wise, double-click on Casw to display CAS subdirectories.
Check the box by Cur (for a current backup) or by
Archive.acv (for an archive backup, if it exists).

6. Click on the Next Step> button.  When a dialog box similar to
the one below appears, select where to back up: for tapes, click
on your tape drive; for floppy disks, click on your floppy drive.

7. Select Save As... from the File menu.

a. When a dialog box similar to the one below appears, select
to save in the Bin directory under the Casw directory.

b. Back at the CASW22 Properties dialog box, click Add and
select Personal Folders. Enter the file name (casw22.pst)
under your CAS for Windows directory — for example,
c:\casw\casw22.pst — and click Open.

 When the Create Microsoft Personal Folders dialog box
appears, click OK.  DO NOT ENTER A PASSWORD.

c. Back at the CASW22 Properties dialog box, click Add and
select Personal Address Book.  Under the Personal
Address Book tab, enter the file name (casw22.pab) under
your CAS for Windows directory — for example,
c:\casw\casw22.pab — and click OK.

5. Back at the CASW22 Properties dialog box, click OK to keep
these settings and exit.

6. If this is a “first-time” configuration or your Inbox is not in your
Start-up group, the Inbox Setup Wizard includes the option
Add Inbox to the StartUp Group.  Check this option to have
Microsoft Exchange running at the same time CAS for Windows
is operating.  Click in succession Next>, Finish, and Close.

A "first-time" configuration starts Microsoft Exchange automati-
cally after completing the above — so if this is the case, you may
proceed directly to Step 8.

7. Back at the desktop, start Microsoft Exchange by clicking on the
Inbox icon. Then complete the following steps:

a. Select Options from the Tools menu. Then select Always
use this profile and verify that CASW22 is displayed.  Click
OK to save settings.

b. Select Address from the Tools menu. Then select New
Entry from the File menu.

c. Select Fax and click OK. Enter the Name to show on
cover page (the recipient of HackerTracker fax alarms) and
his/her Fax Number.  Click Apply, then OK. Close the
dialog box and leave Microsoft Exchange running.

8. Access CAS for Windows and select HackerTracker Criteria
from the Administration menu, then FAX Setup.
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Installing Microsoft Fax

First, check if Microsoft Fax is installed: double-click on the Inbox
icon on your desktop (if the Choose Profiles dialog box appears,
simply click OK) and select Services from the Tools menu. If
Microsoft Fax appears as one of the services, it is already installed
and you may proceed to Setting Up Microsoft Exchange.

1. From the desktop, select Settings from the Start menu, and
then Control Panel. Double-click on the Add/Remove
Programs icon and select the Windows Setup tab.

2. Scroll down to Microsoft Fax and check its box, then click
Details to verify that Microsoft Fax Services and Microsoft
Fax View are both checked.

3. Follow the on-screen instructions to complete the installation.

Setting Up Microsoft Exchange

1. If this is a “first-time” configuration, double-click on the Inbox
icon on your desktop. When the Choose Profile dialog box
appears, click on the New button and proceed to Step 3.

2. If a configuration already exists, double-click on Start, select
Settings and then Control Panel. Open the Mail and Fax icon,
click Show Profiles on the resulting dialog box, and then Add.

3. When the Inbox Setup Wizard dialog box appears, select
Manually configure information service, click Next>, enter a
Profile Name (CASW22 is recommended), and click Next>.

4. When the CASW22 Properties dialog box appears:

a. Click Add and select Microsoft Fax. Under the User tab,
enter Your full name (the sender of HackerTracker faxes)
and his/her Fax Number.  All other information is optional.

Click OK, then Yes. When the Modem dialog box appears,
select the appropriate modem and click OK.

It is advisable to use a dedicated modem (i.e., other than the
HackerTracker pager modem) to avoid port contention when an
alarm occurs and CAS tries dialing out to both devices.

b. Type the file name for the type of backup and media that
you want to define (use the table below) and then click
Save.

Backup Media Set File Name

Full CAS system floppy diskette caswdsys.set

tape caswtsys.set

Current CAS data floppy diskette caswdcur.set

tape caswtcur.set

Archive CAS data floppy diskette caswdarc.set

tape caswtarc.set

8. Repeat Steps 5 to 7 until you have completed the definition of all
backup sets (full, current, and archive) for the type of media you
will be using.  When complete, exit the Backup function.

Backing Up Data

1. Have your supply of formatted backup media ready, then load it
into the appropriate drive.

2. Access CAS for Windows and select Backup from the Utility
menu.

3. When the dialog box appears:

a. Select the media and the accounting period to backup and
click OK. Follow the prompts to continue.

b. When complete, label the tape or diskettes with the backup
dates and sequence (if necessary).

Restoring Data

CAUTION

Restore overwrites data.  Do not restore to your current directory.
Also, do not proceed unless you have a recent backup of your full
system, current, and archive databases.  Finally, before performing
a full or current restore of data, shut down CAS for Windows.

1. From your desktop, select Run from the Start menu, enter
backup, and click OK.
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2. Click the Restore tab. Then in the Restore From field, choose
the media type that contains the data you are restoring.

3. Select the Backup Set you wish to restore, then click Next
Step.  You may experience a delay while Backup searches for it.

4. Check the box next to casw and click Start Restore.

5. When complete, close Microsoft Backup. If a CAS for Windows
shutdown was necessary, select Run from the Start menu,
enter emlog, and click OK.

G3-MA Data Transfer Option

If you are using CAS for Windows with a DEFINITY® Enterprise
switch, you may use Windows 95 network sharing tools to set up the
G3-MA Data Transfer Option.

For example, at the G3-MA PC, after you set up the G3-MA data
transfer directory ("AUTODIR" under C:\G3-MA), proceed as
follows:

1. Use the Explorer to
find and select
AUTODIR.

2. Open its Properties
under the Explorer's
File menu.

3. Click on the Sharing
tab and select Share
As, Full access type,
and no passwords.

(see sample)

This change affects Pages E-3 and E-4 in the CAS for Windows
Installation and User's Guide.

Software Installation

To install the CAS for Windows software, insert its Setup diskette in
any disk drive, select Run from the Start menu, and enter the drive
letter followed by ":setup" (for example, a:setup for the A drive).

This change affects Page 2-4 (Step 2) in the CAS for Windows
Installation and User's Guide.

Remote Access

You will be shipped the new version of the Remote Access software
(Carbon Copy 3.0), compatible with Windows 95. This includes
updated documentation to install and configure the "Host" package.
If you are using the "Guest" package, you will receive its
documentation, Microcom Carbon Copy Version 3.0 for Windows
(Microcom 24-0000839-001).

This change affects Page viii (Related Resources) and Appendix F in
the CAS for Windows Installation and User's Guide (use information
from the new documentation).

HackerTracker FAX Setup

The system now uses Microsoft Exchange to fax HackerTracker
alarms. This requires installing Windows 95 Microsoft Exchange and
Microsoft Fax and performing a preliminary setup.

Installing Microsoft Exchange

If the Inbox icon appears on your desktop, Microsoft Exchange is
already installed and you may proceed to Installing Microsoft Fax.

1. From the Start menu on your desktop, select Settings and then
Control Panel.

2. Double-click on the Add/Remove Programs icon, select the
Windows Setup tab, and check the Microsoft Exchange box.

3. Follow the on-screen instructions to complete the installation.



Addendum-2 Addendum-11

Hardware Requirements

The recommended minimum PC configurations are shown below.

Class/ RAM Monthly Call Available Hard Disk (Mb)
Processor Speed (Mb) Record Volume 1 month min 2 mths

486 / 33 8 250,000 60 200

486 / 100 12 500,000 80 250

Pentium / 90 16 750,000 100 300

Pentium / 133 16 1,000,000 140 500

Pentium / 166 16 over 1,000,000 280 1200

Software Windows 95 default settings + Backup Disk Tools,  NO disk
compression tools

Devices Windows 95-compatible bus or PS/2-type  mouse, VGA color
monitor, parallel printer

Windows 95-compatible multi-port boards such as the Comtrol
Rocket Port Board (if more than 2 serial ports are needed)

Windows 95-compatible tape drive — 120, 525, or 1,000 Mb

Serial
Ports

Single site: COM1 = Remote Access; COM2 = SMDR input.
Systems using the Call Sender and/or HackerTracker
FAX/pager modems require a compatible multi-port board
(options, Remote Access may share either modem).

Multi-site systems require multi-port boards:

COM1 = Remote Access; COM3 - COM10 (or higher, if using
more than one 8-port board):

— 1 port per direct SMDR input

— 1 port per modem polling 10 sites

— 1 port for Callback Receiver modem (optional)

— 1 port for HackerTracker FAX/pager modem (optional,
Remote Access may share this modem)

These changes affect Pages 2-2,  C-2 in the CAS for Windows Installation
and User's Guide.

Creating Colored Icons

If CAS for Windows icons appear in black and white, use the steps
below to change them to colors.

1. Shut down CAS for Windows and return to your desktop.

2. Click the right mouse button and select Properties from the
resulting menu.

3. Select the Settings tab and set the Desktop area for at least
800x600 pixels.

4. Change Font Size to Large Fonts and click Apply.

5. Click Yes to Restore PC.  This causes CAS and Windows 95 to
automatically restart.

Monitor resolution and card styles can vary.  If this procedure does
not produce color icons, repeat the procedure except for Step 4.
Instead of changing to large fonts, click Custom and enter a font
scale of 150% or greater.

Viewing CAS Icons on the Task Bar

Recommendations for viewing CAS icons on the Windows 95 task
bar are listed below:

If your have multiple CAS sites, your task bar may have too
many icons to view clearly.  Increase the size of your task
bar to fully view all icons.

If you set the task bar’s properties to “auto hide” you may
not see CAS alarms when they occur.
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Enabling HackerTracker Audible
Alarms

HackerTracker now has the option of an audible alarm.  If you wish
to hear a “beep” when an alarm is issued, follow the steps below:

1. Access CAS for Windows and select HackerTracker Criteria
from the Administration menu.

2. Complete the dialog box to setup a site’s criteria and click
Apply.

3. Click Edit and check [X] Beep on Alarm.

The Beep on Alarm feature is either enabled or disabled globally
for HackerTracker. This includes all criteria sets and, in a multi-
site system, all sites.

4. When complete, click Apply then Close.

This change affects Pages 8-4 and 8-5 (new feature "Beep on Alarm")
in the CAS for Windows Installation and User's Guide.

CAS for Windows
Version 2.2 Addendum

CAS for Windows™ Version 2.2 upgrades your CAS software for
use with Windows 95®.  Use this addendum as a supplement to the
CAS for Windows Installation and User's Guide (555-006-517, issue
1, August 1995). The specific page numbers affected by the new
software version are indicated by a  .  The changes include:

New PC hardware requirements

Windows 95 Startup utilities to install CAS software

New, Windows 95-compatible version of the Remote Access
software (Carbon Copy 3.0)

New FAX driver for the HackerTracker pager/FAX options

Windows 95 Backup and Restore utilities to support tape
and floppy disk backups

Windows 95 network sharing utilities for the G3-MA Data
Transfer Option

Creating CAS for Windows icons in color and viewing them
on the Windows 95 Task Bar

Setting up an audible HackerTracker alarm

Please review the following pages and make the necessary notations
in your CAS for Windows Installation and User's Guide.

The CAS dialog boxes and icons now have a Windows 95 "look."
These elements, however, retain their original functions.

Familiar icons appear as buttons at the bottom of your screen and
dialog boxes — except for the title bar — appear exactly as their
Windows 3.1 counterparts shown in the CAS for Windows Installation
and User's Guide.
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